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Copyright Quantext, Inc.

Quantext’s portfolio planning tools were createdhétp you analyze your portfolio and
to help you understand whether your risk/returrratizristics and savings rates are
consistent with your future desired income. Thasument provides a ‘quick start’ guide
to using Quantext’s portfolio planning tools. (Ti@de is compatible with QPP, QPP40
and QRP, though we will use “QPP” in the text.)

While we have several guides that explain not dfibynte Carlo style analysis for

portfolio management in general, but also practisplects of using QPP, this short paper
will simply walk you through the initial set up abdsic applications. There are many
important concepts that are not explained herethsiwill provide the basics for getting

you up and running. The other Guides are availabdevw.quantext.conunder the

menu itemUser Guides

Many articles and papers about Quantext’s portfollamning tools are available at

www.quantext.conunder the menu iterrrticles More articles are available at

http://seekingalpha.com/author/geoff-considjard this site provides a search tool for

finding Quantext’s articles pertaining to topicattlfou may be specifically interested in.
For example, search “Geoff Considine diversificatip Still more articles are available

at http://www.advisorperspectives.com

The goal of this paper is to help any person setngorun QPP in about an hour. So let’s
go.

Check system requirements

For PCs: You must have Microsoft Excel 2002 or newer@®P andQPP4Q You
must have an operating system that supports yasioveof Office.




QRP runs on versions of MS Office from 2002 to 2006does not run on MS Office
2007.

For Macintosh: Apparently, EXCEL is not truly 100% compatible @vhrun on a Mac.

A workable solution is the following:

If you have an Intel-based Mac you dalndows, MS Office, and Parallels(which
gives you the ability to switch to a whole diffet@perating system on the fly. Parallels

costs about $80. www.parallels.com)

Once you hav@arallelswith Windowswith MS Excel it is easy. You just start
Parallels, make sure the networking part is workeng. by opening a browser in the
Windows session and making sure you can get somejvh&hen open Excel and follow

the directions.

Company Networks: Some networks do not allow files/programs to bemloaded.

Please check with your network manager to seesfwiil be a problem.

Get the Program onto your Computer

Licensed Users: Scroll down to Licensed Users.

Trial Users: Here is the downloading and extracting (unzippimgcess in detail:

By following the directions below for a downloadyuyare accepting tHdser Agreement

(so you will want to read it) - the full address is

http://www.quantext.com/subpage2.html

If you accept this agreement, proceed:




Enterhttp://www.4shared.com/dir/1028747/fa591c9a/shahitml in your browser.

After hitting the square button with the green ar(the download button) for
QPPDoptions32.zip (or whatever your version oftthe is: 32, 33, 50, etc.), it takes
you to a 4share.com site where you hit the bluewBload Now, no viruses detected”
button in the center of the page. It will ask yowvait for under a minute, and then offer
a button entitled “Click here to download this file&crom here, it kicks you back to your
computer where you choose SAVE. (Save it somewleghén your My Documents
folder.) It then downloads. When it is finishgdu can choose OPEN. Then it takes
you to wherever you saved the ZIPPED FILE on yamguter. You double click on it.
It takes you to a place where you can do thingkédile. On the left side of the page,
you can choose "Extract All Files". Do this. Alxtraction Wizard" will help do this;

push NEXT when it wants you to.

For MS Office 2007 users: When it shows you tlomiof the downloaded folder with
the zipper on it, please Right Click on the fold&elect Extract. Then it will extract the

files and show you a folder without a zipper. TiBigour useable folder.

Licensed Users: Your licensed version will come on a cd. Simply fhe cd into the

disc drive. If a window does not automatically pgp then go to the Start Menu and
select My Computer. In this window you should geedisc drive. Select the disc drive.

Once the disc drive window is open, you shouldsséeder labeled QPP (or QPP40 or
QRP). Do not open the folder here. Instead, R@jltk on the folder, and select COPY.

Go again to the Start Menu and this time selectdguments. Within My Documents,
go to any folder that you choose. You may nameftiider whatever you like. Open the
folder and Right Click on a blank area in the wiwddSelect PASTE. Now you may
open this folder by double clicking on it. (You yn@eed to do this a couple of times

before you see the set of files.)

One of the files will be an Excel file (.xIs). BisQPP.




In the case ofRP, there will be two .xls fileSQRP data.xlsandRetirement

Calculator v4.6.xls.

Adjust your Excel Settings

Go to the Start Menu and open Excel. (You may teemb into All Programs and find
Excel if it is not pinned onto your Start Menu.)

For Excel 2002 -2006:

Set Calculations in Excel set to Automatic.On the Excel toolbar, go to
Tools>Options>Calculationand make sure that the button markedomatic is
checked.

Install Analysis ToolPak. You will need to install and enable the Analysis
ToolPak in EXCEL. In the upper tool bar of EXCE&Q tp Tools >> Add Ins and
make sure thahnalysis ToolPakis checked. (You can ugenalysis ToolPalor
Analysis ToolPak VBA If this was not installed on your computer witffice
was installed, you will need the MS Office disdnstall this.

Disable Excel’'s Auto-recovery. The auto-recovery function in Excel can
sometimes cause QPP to hang-up during the datctioh process (when the
program is using the internet to collect data fouryanalysis.) Go to the Tools
menu again and this time sel€gptions >> Save >> click the box to disable

Auto-recover.

Open QPP, QPP40 or QRP from inside ExcelGo to the~ile Menu (upper left corner
of Excel.) Select Open. For QPP and QPP40, rgws’reMy Documentsor

Quantext Portfolio Planner v4.0 (.xIs) Double click on it to open it.

For QRP, browse you’'re my Documents folder dintl Retirement Calculator
v4.6(.xIs) Double click on this to open it. As QRP is oipen it will ask you if you
would like toUpdatesomething.Select NO. Go back to the Excel File Menu, select
Open, browse My Documents fQRP Data(.xls). Open this as well. Both need to be
open to run QRP.
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Make sure that Macros are enabled.Every time that you are opening QPP,
QPP40, or QRP a pop-up window should appear. Wimdow asks you if you

will enable the macros. To run QPP (or other), wiluhave toEnable the
macros. (The program has to be allowed to gomtlidé web and retrieve data on
the tickers that you would like to use in your gsda. If you are uncomfortable
with this, please read * note below.) If for soreason the pop-up does not
appear as you are opening QPP, then you will hatake a couple additional
steps. Close QPP, but leave Excel open. In Efwmel,not from within QPP), go
to Tools > Macros > Security and set the security toaw. Then re-open QPP
from within Excel (File > Open > ... Quantextrifalio Planner v4.0). For re-

opening RP, see notes above.

*QPP requires the use of a macro so that the pmogem go onto the web, retrieve
data, and bring it back to the program for analy&igcel cautions against setting the
security to low unless you are running only magragjrams that you trust. Though
there is a macro certification program, it is cpstQuantext has intentionally tried to
keep the cost of our software low. To this end,|&t our users certify us. So far, we
have not heard of anyone having problems with tkeeEsecurity being set to low

for the use of Quantext’s products. We invite yoget on the forum and ask the
other users if you have hesitation about settieggkcel security to low. Here is

information about joining the forumhttp://quantext.com/subpage.htr(iThe link to

the forum is on the Quantext website here.)

Note: In general, yodo not need to change your computer security to use QeRve

your Norton/Symantec Settings (or other similaiusi#g company settings) as they are.
McAfee is the one exception; McAfee users will néeébllow these instructions:
Click on the "Personal Firewall Plus" tab of theAffiee Security Center.
Click on the "Options" tab. The Personal Firevills pop-up screen will
appear.
Click on the "Internet Applications" tab on the &aral Firewall Plus pop-up

screen.




Scroll down the applications list until you reatle t' Microsoft Office Excel" line.
Highlight this line.
Change permission to "outbound access only" (indtver right hand corner of

the screen.)

Enter Your Name and Password

Trial Users: Your name and password are at the bottom ofrteglevith the Download

and Run Guide.

Licensed Users: Your name and password are given on the halft gw®mpanying the
CD.

You enter the name and password in a couple ofdbtaxthe RIGHT of the yellow boxes
on page 1 of QPP once you have opened QPP. Sapkpwve their screens 'zoomed
in' so that the username and password boxes dghoat (even after scrolling up to page
1). If this is the case, you will need to scrolboto the right a little bit to see these

boxes.

After entering your name and password, look atbitre marked Annual Standard
Deviation (in yellow) near where you enter yourrasene and password on Page 1 of
QPP. If that reads 15.07%, skipS®EP 5 If that reads 0%, QPP will not run. There
are several possible causes:
You have entered your username and password irtigrrdViake sure that you
have no extra spaces and have matched the cagii@ion the username that
was sent. Though the username may appear to pacessin front of it, it does
not. There are no spaces before or after the naistegne between first and last
names. There are no spaces in the password.sHeee’check™: As yoenter
the name and password correctly, the 0% changEs.87 %. (Be sure to hit
‘enter’ for the number to change to the non-zero!)




Another possible cause is that the trial or therged version has expired. The
expiration date is directly below the User namedsiard area.

Another possible cause is that the Name/Passwanth@ds not consistent with
the version that you are attempting to use. (kanwle, your trial password will
be different than the password for your licensedgioa.)

Please contadtygpp@yahoo.conf you have carefully gone through STEPs 1-4
and cannot get the 15.07% to appear.

Open an Internet Connection

You will need to be connected to the InternetGat Datafunction to work.

Familiarize Yourself with the Layout of QPP

QPP is organized as a series of pages in EXCELm@dwe through QPP, you scroll up or
down. You can use the arrows or “page up” or “pdgen” buttons on your keyboard.
The entire report is print formatted, so if younpyiit will come out nicely formatted.

If you have Adobe Acrobat Writer, or one of theefnariants (such as CutePdf), you can

print to this and generate nice email-able reports.

Let's Run QPP

Please Note: This portfolio planning software, tentin EXCEL, is provided on an AS IS
basis. No warranty whatsoever is provided. Tbfsasare is copyrighted property of
Quantext, Inc. and shall not be reproduced whally gart without the explicit written
permission of Quantext, Inc.




| Microsoft Excel - Quantext Portfolio Planner v4.0

@ Eile Edit WView Insert Format Tools Data Window Help

Quantext Portfolio Planning Report

Prepared For: Preparation Date:

Your Name 12/6/2005

Page 1: Basic Input and Economic Projections

L QUANEeELEOm

Note: Please see the end of this report for important disclaimers

Annual Standard
Aszumed

. i Deviation of
Current Age 40 Inflation Rate | Market Retum (%

Date of Retirement

Annual Standard
Deviation 15.07%
Annual Contribution (2003 $14.000 Average Annual
Dollars) o Delta Return | Return of Markst

Current Portfolio Value -2.00% 8.30%

Inflate Contributions at . . _ . B

inflation? LEE 3\0[35 EJal[a Return is your estimate of

Tnflace Tncome Draw? the difference betwaen annual return in
nlate t_l“ Um‘_ TawW . the futurs and historical annual return

Income in Retirement from the S&P300

(2005 Dollars)

Age at Retirement

OR.

Target Percentage Draw

Minimum Draw (2003
Dollars)

Note: if you want to use a constant income draw, sef the percentage draw to zero

W 4 » M|\ Portfolio Report/

In QPP cells in redare those that the user may alter.
Enter all of your information on the left side. tddhat the “Age at Retirement”
is calculated by QPP.

For now, leave the right side alone—this has realslendefault settings for the

market.
The lower box (below “OR”) allows you a more coneplied income choice, but
leave the Target Percentage Draw = 0% for thiskgstiart. We will assume a

constant annual draw (with the option to escalatk inflation.)




In QRP, the elements of the program are laid dégrmintly, but the elements are
the same. Please look at the first several pag@&Re for the elements being
discussed in this Guide.

When you are done, scroll down or RgDn.

Have QPP Get Historical Data

On Page 2 of QPP, you enter your tickers (fundtiyidual stocks, ETFs, etc.) For the

Quick Start, let’s use the tickers preloaded ih® doftware. They may be different than

the ones shown in the picture, below.

| Microsoft Excel - Quantext Portfolio Planner v4.0

Flle Edit View Insert Format Tools Data Window Help

Prepared For Preparation Date

Your Name 12/6/2005

Page 2: Portfolio Components

Standard
Fund or Stock Ticker Beta Deviation 2
(Annual) Start Date End Date
15% % K 12/1/2002 12/1/2005
0% % K
oo o " Get Data
23% 5% K Months Years
36 2.0

W 4 » W]\ Portfolio Report / |« |

Notice that the symbol “-* (no quotes) is in atiker slots that do not have tickers
in them. This is important. (See last cell in dodumn above.)

Enter aStart and End Datefor the historical data (on right side of screbo\e.)
You may use the dates that are currently therehoose to alter the dates. Please
notice that the Start Date must predate the End!Détiree or four years of data

up to the most recent month is a good choice.




Click theGet Data button. The program goes onto the web and retrieves
historical data and calculates historical statssftbis can take some time.)

If every row in the Check column says OK, you can ove to STEP 9.

If you returned to page 2 of QPP only to find onenmre error messages in tGbeck
Column and would like to continue with thleuick Quick Start, you can simply change
any ticker that has come back with an error mesgageY, hit Get Data again, see OK
fill the Check Column, and move on$3EP 9.

If you received an ‘Error Message 1004’ or you veblike to learn how to troubleshoot

an error message in Check Column now, continue:

Error Message 1004: (If you are stuck on the yellow and green ‘Caltinigi page, to
get back to QPP, click the ‘Portfolio Report’ tatitee bottom of the Excel sheet.)
All of the STEPs up to now are important in allog/i@PP to perform the Get
Data process successfully. Here is a list of exasngs to what could cause the
Error Message 1004: trial version still in zipdedmat, Auto-recovery not

disabled, Calculations not set to Automatic, tryiagun QPP from CD directly,

password not entered correctly.
Another possible cause is that one or more ofithers are not acceptable. See

Tip 12 in the Troubleshooting Guidettp://www.quantext.com/gpagel.html

Another possible cause is that the date and/or eufobmatting are not in US
English format. See Tip 13 in Troubleshooting Guid
http://www.quantext.com/gpagel.htmi

Try replacing all of the "-" symbols (in the slots wlgou enter tickers) with real
tickers--use SPY, for example. You can allocags¢hextra tickers to zero later.
In some versions of Excel, there seems to be ahaignakes QPP refuse these
symbols, however, you cannot leave a ticker slanll

For the full list of possible causes, see Tip 1thm Troubleshooting Guide:

http://www.quantext.com/gpagel.html




‘Bad Data’ or ‘Short Record’ in Check Column:
If a ticker results in a ‘bad data’ or ‘short redoin the Check column there are several
possible causes:
The ticker does not exist (or is mistyped.)
The ticker is not listed at Yahoo!Finance with bigtal data. Please see our
Troubleshooting Guide, Tip 12, for more informateimout this.

http://www.quantext.com/gpagel.html

The ticker is not typed exactly as listed at YdRamance.
The time period selected is not consistent withdiia history for that stock or
fund at Yahoo!Finance. Please see our TroublesigpGQuide, Tip 12, for more

information about thishttp://www.guantext.com/gpagel.html

A Look at What we Have

Once STEP 8 is complete, the program has collentddtalculated the basic inputs for

the Monte Carlo simulation. Standard DeviationtaBand R”2 (also called R-squared)

are all measures of risk for each of the portfobonponents, and these are shown on
Page 2 of QPP.
See www.Investopedia.com for definitions:

RA2 : http://www.investopedia.com/terms/r/r-squared.asp

Beta: http://www.investopedia.com/terms/b/beta.asp

Standard Deviatiorhttp://www.investopedia.com/terms/s/standarddewatasp

PgDn or scroll to next page of QPP, Page 3.

Allocate Portfolio

On page 3 of QPP, enter your portfolio allocatidfm. the Quick Start experience, you
can use the allocations that are there, or chdrege.tMake sure that they sum to

exactly 100%! (This is shown at the bottom of the Percentageunids column.)
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| Microsoft Excel - Quantext Portfolio Planner v4.0
File Edit View Insert Format Tools Data Window Help

Portfolio Planning Report

Preparzd For: Preparation Dats:

Your Name 12/6/2005

Page 3: Portfolio Allocations and Monte Carlo Outcomes

Portfolio Stats
Percentage of | Averags Annual | Awerage Annual | Standard Deviation Increase in Average
Fund Name Funds Raturn Basturn (Annual) Ticker Return (%)
I?Tlc 4 o e 14559 16.12% o
DUK 22.05% DUK
EXC 8.0% 2.01% Historical Data EXC
0e End: HOM
10.63% 12/1/2002 12/1/2005 drd
25.04% Average £ Standard Deviation MTH
21.06% 2 {Annual) EXPO
10.76% - EF&
24.03% FIC
19.41% Historical Beta: 95.64%0 ACN
25.30% MMC
§47% sPY
9.45% Performance of $&P300 over historical JAMRX
6.65% period FRURK
13.50% Average Annual Return on S&P300 WB
13.35% 12.55% C
12.74% Amnnual Standard Deviation on S&P300 WM
8.47% 0.10% IYH
§.30%

Sums to

Market Index (S&P300)
. L Average Annual | Standard Deviation
Simulated Portfolio Beta T {Anual)

98.37% 8.30% 15.07%

4 4 » M| Portfolio Report /

Enter the percentage of your portfolio that isacle holding.

Blank values are equivalent to zeros.

Make sure that th8ums toline equals100%.

Note that you cannot change the tickers on thie pdde tickers will be carried

down from Page 2 of QPP.

Thered cellson theright hand sideallow you to either add to the projected

annual return or decrease it due to a poor outtwd&ads (advisor fees). For our
purposes today, we will leave these settings asdahe However, here is a brief
note on this: periodic fees in mutual funds at®@uatically accounted for in
QPP, whereas, to account for loads in mutual funds, gfwould input a negative
percentage. To arrive at a reasonable numberid=rtsow long you typically
hold a fund; for example, if there is 5% load ciuad, and you are estimating

that you will hold it for 5 years, enter -1% forthfund.




A Look at the Results

Once STEP 10 is complete the results are readye’$t&hat we have:
Portfolio Statsshows the projected portfolio average annual netund standard
deviation. Note that this is dependent on therassufuture market conditions
(gray cells in lower right, which, for our Quicke®t purposes, we are leaving as
originally set.)
TheHistorical Datatable shows the performance of this portfolio ahthe
S&P500 over the historical period selected by yoyage 2 of QPP (near the Get
Data button).

The assumelbng termmarket conditions are carried to the Gray cells at the

bottom right corner of this page. These are adpiston page 1 of QPP.

For more information about the results, please readur
QPP Contents Guide atttp://www.quantext.com/gpagel.html

Ready to Play and Learn

From here, you can play with many of the inputs iastantly see the effect on the
projected behavior of the portfolio. (If QPP does$ update the calculations
automatically, check that Calculations are stitlteeAutomatic. See STEP 3, above.)
Try adjusting:

portfolio allocations on page 3 of QPP

Date of Retirement

Annual Contribution

Inflation rate

Inflate Income Draw? (This will in inflate Incone Retirement.)
Note: If you adjust thélistorical Period or thetickers (page 2 of QPP) you will need to
hit Get Data again.

For more information about the input or output, please
read our QPP Contents Guide at

http://www.quantext.com/gpagel.html
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Retirement Planning Tool

On page 4 of QPP, you will see not only the prpigychart (just showing the allocations
of the portfolio) but also, and more importantlye tittle box labeledProbability of
Running Out of Money. For such a little, non-assuming box, it contgaowerful

information; this is showing you the probabilitiéfsfunding your retirement.

| Microsoft Excel - Quantext Portfolio Planner v4.0

Eile Edit View Insert Format Tools Data Window Help

Portfolio Planning Report

Prepared For: Preparation Date:

Your Name 12/6/2005

Page 4: Summary Outcomes

i Quantest.eom

o sPY
| INTC
O DUk
O ExC
| HOMN
[=RU0A

= MTH
O ExFO
mEFA
= FIC

O ACH
o MKMC
m EPY
u JAMR
| FRURX
uwE
=)

o I'wM
ovH

Age at Retirement: 60

Portfolio Stats

Probability of Running Average Annual | Standard Deviation
Out of Money ) Return (Anmual)
0%
Loes 14.55% 16.12%
20%

250

o
30% Portfolio Beta:
35% 98.37%
40%%
M 4 b M} Portfolio Report /

This chart is the culmination of all of the inpatfar. It shows the probability that the

portfolio will run out of money by a certain agetbé owner (as specified on page 1 of

QPP.)
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Let’s take a look at the example pictured abovkis person has a 20% chance of
running out of money by age 82 under the curresnh pIThis person also has a 25%
chance of having his/her money run out by age M&u can go back and change any of
the inputs and these results will update automigtic&€hanging age, portfolio size,
annual contribution, etc. causes instant updatessiadts. Changing one variable at a
time allows you to explore how each variable aBegaiur retirement plan. What does
working two extra years do for you? —Two fewer g@aiHow are the outcomes affected
if you put 100% of your money in AGG (allocatingethther tickers to 0%)? What about
100% in SPY? —what about DVMKX? (DVMKX is a putdily traded money market
fund, which, by the way, can be used as a proxgdsh, or non-publically traded money

market funds.)
Note: If you change the list ¢itkers or thehistorical period (page 2 of QPP), you
must re-rurGet Data If you just change the percentages of the plasttdiocated, you

do not need to re-ruBet Data

When you are done here, scroll down to the next md@PP.

A Look at the Other Features

When Do | Become a Millionaire?

Page 5 of QPP gives you the estimated portfolioevgkar by year. Both the2and

80" percentiles are given, along with the median ptej outcome. To understand this
chart, you will need to know a little about howisitgenerated. A Monte Carlo Simulator
essentially rolls the dice @fiture possible outcomélsousands of times. Statistics is used

to make sense of the outcomes.




‘ Microsoft Excel - Quantext Portfolio Planner v4.0
File Edit Wiew [nsert Format Tools Data Window Help

Portfolio Planning Report

Prepared For: Preparation Date:

Your Name 12/6/2005

Page 5: Estimated Portfolio Value

Median Portfolio] 80th Percentile | 20th Percentile
Value Value Nalue
2003 | 5101,009 5101912 5100,020

2006 5148.263 5114361
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(SO

Read the0d" Percentilethis way: “In 20% of the future possible outcommey, portfolio

is this value or less.” In 80% of the future poksitutcomes, the portfolio has more.
This is an indicator of what a grimmer future migbtd.

Read the30" Percentilethis way: “In 80% of the future possible outcommy portfolio
is this value or less.” In 20% of the cases, thfplio has more. One can think of this

as the rosier future.
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Themedian value is the 58 percentile, right in the middle of all of the fuéupossible

outcomes.

When Do | Become a Millionaire?

Going back to the example, this person has a 2G#aehof becoming a millionaire by
Age 50 (in the year 2015.) This is thé"ggercentile.

This person also has a 20% chance of only reaéhimdlion-dollar portfolio by age 55 -
-- the 20" percentile.

When you are done here, scroll down to the next¢ @@ PP.




Getting comfortable with short-term risk

Page 6 of QPP projects short term behavior.

| Microsoft Excel - Quantext Portfolio Planner v4.0

File Edit View Insert Format Tools Dats Window Help

Portfolio Planning Report

Prepared For: Preparation Date:

Your Name 12/6/2005

Page 6: Porifolio Risk and Projected Return

Portfolio Value: $100,000 comments |

Time Horizon (days): 60
Porifolio Beta: 08.37%

Percentile Portfolio Value | Gain / Loss
1% £87.832 -$12.168
3% £01.428 -$8.572
10% £03,780 -$6.220
15% £95 460 -54.540

£06.8a66 -53.134
25% £07.81¢0 -52.181
30% £08,033 -$1.067
35% £100,026 £26
40% $£100,818 £818
4504 £101.681 £1.681
0% §102.521 $2.521
35% $103.361 $3.361
60% £104,009 £4.000
65% £104,918 £4.018
70% £105,890 $5.890
75% $106,766 £6.766
80%% $107.786 $7.786
85% £109,003 £0.003
00% £110,476 £10.476
05% £113,389 £13,380
00%, $117. 616 $17.616
Average 5102,392 $2,392

4 4 » [\ Portfolio Report /

This page allows the user to enter a time horized ¢el| number of days) and
then projects portfolio risk and return over thatipd in terms of percentiles.
This does not account for future contributions.

This portfolio has a 5% chance of losing 9% or nudriés value over the next 60

days, for example.




Stock Options Tool

Pages 7 and 8 of QPP are the Stock Options TodEamuloyee Stock Options Tool;

these are one and the same. This feature is onfiittie the trial version of QPP. Details
about the use of this tool are not included in tlisument. Please see these articles for a
demonstration of the use of this tool:
http://www.quantext.com/GoogleEmployeeStockOptipd5.

http://www.quantext.com/GoogleEmployeeStockOpti@rnsdf

Also, the Personal Portfolio Managemepdf (page 70, chapter 5) is quite helpful. This

is found athttp://www.quantext.com/gpagel.html

Read Disclaimers

These are found on Page 9 of QPP.

Do not skip the important disclaimers and inforrmataboutQPP projections.
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This is the end of the Quick Start Guide to QP#thls section of this paper we will
summarize the reasons one would want/need a toblauQPP.

The essential value of any Monte Carlo style pdidfplanner is in showing the real
trade- offs in portfolio risk and return. A lowski/ low return portfolio is, in fact, very
risky if you will run out of money at age 70! Adi return / high risk portfolio may
increase your odds of failing to fund retiremeag.t The challenge is in building a
portfolio that gives you the best likelihood of fling your future income needs, given
your current wealth and plans for future contribn§. This balance can only be

determined using a Monte Carlo approach.

If you play with QPP for a while, you will stad tearn strategic asset allocation. You
will see how return and risk are related; see how/@an strategically choose
combinations of equities that help to maintain mesuvhile managing risk. You will see
that effective asset allocation means a stratdlgicadion among a limited set of choices,
not just buying some of everything. This will bew® very clear as you play with various
portfolio allocations in QPP. For more guidancebenoming a strategic investor, please
read Ben Stein and Phil DeMuth’s book entitek, You Can Supercharge Your
Portfolio; this book introduces various investment stradieth good and bad, in a

very readable manner, and then ventures into aress the meat of portfolio theory,

how to take advantage of the free lunch that is portfolio diversification. A little
preview: Diversification is not achieved by buyiegerything, but rather by strategically
choosing complimentary securities. If you arefaatiliar with portfolio theory and the
basic concepts of portfolio allocation, along wiitle above mentioned book by Stein and

DeMuth, we suggest the following two articles fremaestopedia.com:

The Importance of Diversification:

http://www.investopedia.com/articles/02/111502.asp
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The Dangers of Over Diversification:

http://www.investopedia.com/articles/01/051601.asp

Again, many articles and papers about Quantextggim planning tools are available at

www.quantext.conunder the menu iterrrticles More articles are available at

http://seekingalpha.com/author/geoff-considjard this site provides a search tool for

finding Quantext’s articles pertaining to topicattlfou may be specifically interested in.
For example, search “Geoff Considine diversificatip Still more articles are available

at http://www.advisorperspectives.com

This Quick Start Guide has covered only the basatures of QPP. Other tools built in
to QPP include th€orrelation Calculator(helpful for building a truly diversified
portfolio.) This feature is fully functional in ¢htrial version. It is on one of the sheets in
the QPP software; simply click on its tab alonghlb&om of the screen. It contains
whatever securities you have listed on page 2 & Qiter you have hit “get data.” QPP
also includes thEmployee Stock Options Toolhis tool projects a future value for these
hard-to-value entities and seamlessly meshes tkesa#s into your larger portfolio.
Should you sell some of your stock options to dsifg? —This tool helps you to explore
the possibilities. This tool is not available irettrial version of QPP. Another tool is the
Custom DrawTool. (This feature is not included in the trial versieither.) This feature
allows you to look at different saving/drawing sagas for your future. Will you save
consistently until you start drawing consistendigljusting only for inflation? —or will you
have a decade of less intense work in which yothtmgt save, but also not draw from
your portfolio? Not many tools are flexible indlsense. For more information on how

to use this feature, please open the User Guidesrfthat came on your CD. In there,

you will find a pdf called “Income Glide Path- uggride”.




